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| Preamble : Management

» All one does to keep the subject :
— Healthy (up and running efficiently)
— Evolving positively
« Fundamental operations
— Monitoring
« Observe the subject at work ©
— Control
* Act

« change or constrain the behavior of the
managed subject

— Plan its evolution
* Why ?
— Service quality
— Reduce costs
— With limited risks
« Keeping the right level of quality

© MADYNES 2003

Preamble : “management” wording in the presentation

Management

&
Device Management
Service Management

Network Management
Application Management

Configuration  Management
Fault Management
Accounting Management
Performance =~ Management
Security Management

— Unless explicitly stated otherwise.

© MADYNES 2003

| Tutorial Outline

+ Growing Dynamics and their * SyncML-DM : an Approach for
Impact on Management (20 minutes)  Managing Dynamic Devices (60 min)
— Dynamics — Representation Protocol for Device
— Collapsing time scales Management
— The need for automation and — Device Management Protocol
autonomy — Standardized Objects

— Management solutions for the
dynamic world
— Standardized approaches
— Emerging alternatives
* JMX : Dynamic Management .
for/through the Java World (60 min)
— Basic Concepts
— Dynamic components

« Attribute, method & notification
level

* Managed Object level
— Remoting
— Implementations
— Application domains &
instrumentation patterns

— Device Management Tree
— Security for Device Management
«  Case studies (40 min)
— Ad hoc networks management
Conclusion & discussion (15 min)

© MADYNES 2003

Dynamic systems we are interested in :

* In general :
« A system that changes its state over time »
[Jakobson 2001]
» From a management plane point of view :

« A system that changes its state over time in such a
way that changes cannot be detected or processed
efficiently by the management plane »
— Because they occur too fast
— Because they occur too often
— Because they occur too slowly

— Because their processing requires changes in the
management plane

© MADYNES 2003

Dynamics Everywhere in Networks and Services !

» Topology related dynamics
— Ad hoc networks : connectivity, reachability, autonomy

— P2P networks & overlays : availability, presence, contribution,
topology

— Mobile networks : mobility, power, usage
» Capacity related dynamics
— Constrained power environments
— Vertical handoff & Associated QoS variation
» Services & Service Infrastructure level dynamics
— Software radio, extensible terminals
— P2P networks & overlays
— Active networks : protocols change, functionality extension, ...
— Service platforms : service life cycle, hot deployment, update, ...
— Service usage : discovery, trading, late binding, lease, subscribtion
» Device, Network & Service Management Dynamics
— Online SLA parameters (re)-negociation
— Management interfaces tailoring

© MADYNES 2003




[ Collapsing Time scales

« Static Management
—  Manager/MIB/Agent
— Manual configuration of participating entities
- Homogeneous management domains
—  Pre-sharing of management information models
— Size : 1to afew hundred
— Time Scale
+ Few minutes up to a few month

« 1-8 years for information models
(standards)

S COREL Jain, f
- | J2E . Dynamic Management
et ghey

— Infrastructures, services, usage & mobility

- m:é!.mmm B P %;“g;:m s - MuI‘(ip\e, §hared evolving administrative domains
B EE!EEBBEBE! = m ) ~ Variable ir models and
Emom i) interfaces
- i & evolutive functions
| — Size : 1to several millions/billions
by ~ Time Scale

* ms up to a few seconds

New management solutions are needed!

© MADYNES 2003

Management solutions for the dynamic world

1. Change to a static world and keep the
management frameworks as they are !
«  1-6 years to build a management interface

«  Accept that you will at some time end in state #2 !

2. Consider management as a useless interface
and service and stop working on it !
< Start thinking about other ways to QoSing
*  Trust webs, in-band probing, signalling, ...

3. Make management as dynamic as the entities
it manages !

«  Rethinking everything

© MADYNES 2003

* « Many aspects of dynamic systems are often
perceived as static » [Jakobson 2001]
* So lets consider them as static

« As long as theses dynamic aspects do not alter the
external enveloppe.

« Keep the management frameworks as they are
* Mapping in the networking world
— Focus on the service or application level only
— End2End monitoring & performance measurment
— As soon as something becomes too dynamic : ignore It
* History tells us that this is not a good approach
— Often micro-dynamics highly impact the world
* « Butterfly Effect » by E. Lorentz MIT (1961)
« Maybe not the best example ...
— In highly dynamic environments, even management of

the static parts becomes almost impossible using the
usual paradigms

© MADYNES 2003

» Networks and services do not need management anymore !
— They adapt themselves to the provided conditions
— 90’s ALF philosophy with an extension to the active networks community

« But « Nature abhors a vacuum »
— Benedict Spinoza (1632-1677)

* Thus traditional management will be replaced by smart solutions
— From management to signalling
« The case of an evolution : ATM VPC, SVC
— DHCP was an evolution in IP address management

« but not a sufficient one since DHCP needs to be managed and DNS is
required too for the translation (Dynamic DNS is a partial solution)

— Zeroconf, zerouter are other « management free » efforts within IETF
+ No management entity needed
« Initially focused on IP address (unicast, multicast) and name assignment

* Because Unmanaged entities are part of the Chaos !

© MADYNES 2003
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-Mg t & dynamics (3): make management dynamic

+ Divide ut imperes! (Divide & conquer !)
— Julius Cesar (102-40 BJC)
— Manage smaller worlds to manage each better
« Get compliant with each degree of encountered dynamicity
— Build an adequate hierarchy to manage the interactions among the worlds
+ This is NOT an easy task!
* Foster Management Autonomy & Automation
— Avoid human interference
« Self-Anything for the management plane
» E.g. self- i ion of the plane
— Avoid time costly operations
« Like long interface standardization efforts
» New dedicated management languages & models learning,

« Equivalent to the consequence of the previous option
+ Accept & Integrate new constraints in the management plane
— Low connectivity

— Shared / cooperative management, new security models, negociation services
— Unstable domains & entities

— Self monitoring
— Evolving and changing management interface - Self-healing
— Self-optimizing
© MADYNES 2003 -11- © MADYNES 2003 -12-

| Standardized approaches support

+  Mostly focused on Delegation & Distribution
— RMON & RMON2
— SNMP’s INFORM Service
— SNMP DISMAN initiative
« Script MIB, Event MIB, Schedule MIB, Remote Operations MIB,
* Adaptation to emerging constraints
— Dynamic MIB extensibility support
« AgentX & previous efforts like SNMP-DPI or SMUX
« CIM Provider in the WBEM Architecture
— Asynchronous messaging
* MOM’s gain acceptance as a management communication channel
+ Current limits (self-ing)
— Self-configuration
« Service, network, device & MANAGEMENT PLANE !
— Self-provisioning
— Self-instrumentation of services,




" Emerging altemaives

* Delegation support and management interactions remain a « Automation is the focus of many efforts

strong focus ) — Autonomic Computing by IBM
— Active networks based management is one approach — N1 for Farmed resources by Sun

— Mobile agents are another solution — CISCO CNS Configuration Engine & Intelligence Engine ..

— Dynamic Managed objects loading & distribution become common — SelfCon initiative (Nortel & Waterloo U.)
* Dynamic instrumentation is growing fast — Self-aware networks (Alcatel)
— CORBA interceptors - ...
— Web Services Proxies + Promising future
— J2EE management introspection — Several technologies cover parts of the needs
— OSGi service interface monitoring + But do not cover all needs at the same degree
* Automation is increasing + We will examine 2 different ones with different features in the next
— Closed-loop management processes sections ) L
+ E.g. Self optimizing performance (smart scheduling in Web Farms, — Research proposals in automated management are very promising
storage networks, ...) * New « to-be managed environments » appear :
— SLA/SLM automation — On demand, self-service, home service platforms and environments
. Eg{g%lusré? parameters & automated mapping to monitoring & reporting — Ad hoc, sensor, home, wearable networks

— Context sensitive services, including management onces

© MADYNES 2003 13- © MADYNES 2003 _14-

_ JNIX : Java Management Exténsions

+ Growing Dynamics and their + SyncML-DM : an Approach for
Impact on Management (20 minutes) - Managing Dynamic Devices (60 min) +  Why JMX in a tutorial on Management of
— Dynamics — Representation Protocol for Device . . )
— Collapsing time scales Management Dynamlc Networks and Services 7
— The need for automation and — Device Management Protocol . . . .
autonomy _ Standardized Objects 1. Used in dynamic service environments
- Management solutions for the — Device Management Tree — Inspired misuses !

dynamic world

— Security for Device Management : .

~ Standardized approaches . Case stu}:iies 40 min) 9 2. Interesting features :
JKA)Er.ngrglng a_Ite’(/r;atlves — Ad hoc networks management - Multi-level dynamics
: Dynamic Management Conclusion & discussion (15 min) — Great learning curve

for/through the Java World (60 min)
— Basic Concepts 3. Part of the evolution of the management species

— Dynamic components .
2 Attribute, method & notification — Strong heritage from the management roots

level . .
- Managed Object level 4. Excellent Open Source implementations

— Remoting
— Implementations

— Application domains &
instrumentation patterns

© MADYNES 2003 -15- © MADYNES 2003 -16 -

" JMX : Java Management Extensions " JMX global architecture

» Java-based Management Agent Architecture

— Enables Java applications/components to be easily
instrumented in Java Management

— Fosters the use of the Java technology to manage non- Applications
Java environments

* Information Models JMX Distributed - |nmm i‘f
— Set of MBean objects Services
* Managed Objects

ey —
Protocol and InfoModel independent

JMX Agent
— Name + MBean Serviges il | | | j’
» X.500 like naming
_ / JMX Instrumentation !ﬁ
But not exactly the same ! TR MBeans 1!

* Decoupling of instrumentation / export / access

rotocols
P Managed "
Resources =]

© MADYNES 2003 -17- © MADYNES 2003 -18 -

Source: JMX™: Status,
Roadmap and Directions
Session TS 720,
JavaOne 2000




T IMX: Managed Objects

« Simplified vision
A management interface =
MBeanInfo
« Exposed Attributes
* «invokable » methods on the
management interface
« 3 levels of MO programmability
— Who builds the management
interface ?
« The agent through introspection

 The application as a demand
made by the agent

« The agent through an external
order
— What is the dynamics of the
interface ?
« Defined at compile-time
« Atrun-time
— Who build the Managed Object

MBeanServer

that supports the interface Managed
« Application developper Application
« The agent, through delegation Resource

© MADYNES 2003
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" IMX: Managed Objects

« Standard MBean
— Management interface defined at
compile-time
— Interface discovered by the agent at
object registration time
— +/-
« Simple model
« Interface is Static
* Dynamic MBean
- Exposed Management interface is
built at run-time
— Management interface delegated by
the agent to the MO
— /-
« Coding Overhead
— MBeanlnfo, get, set, invoke, ...
+ Context sensitive management
interface setup made possible
(remember the conditional packages
ié)the OSI management framework

2:Discovery /
Introspection()

Application
Resources

MBeanServer

1:Register()

nt
Inferface

3: management

Application
Resources

© MADYNES 2003 _20-

RS Managed Objects

* Open MBean MBeanServer

— Dynamic MBean with :
* Restrictions on possible types
— Method parameters
— Return types
« Extended MBeaninfo
* Model MBean
— Resource delegates the
« coding » of the MBean to the
MBeanServer
— Interface defined at MO run-time 1
— + /-
* Ideal model for NON-
management specialists
* Marvelous free services :
— Cache management
— Persistance
— Logging, ...

(2) creation
& Creation Interface

\(4) ink »'/rlr

Appl/caﬂon

kesowe

© MADYNES 2003
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| JMX : a small Standard MBean example

// Tnterface

public interface PrinterMBean {
public Integer getMaxCopies():
public void setMaxCopies(nteger n);

public class MonApplication {

// The agent
private MBeanServer myMBeanServer =

private Integer supCopies = 2;
private PrinterStatus fStatus;

public Integer getMaxCopies()
{return supCopies:}

public void setMaxCopies(Integer pSubCopies)
{fSupCopies = pSubCopies:}

public PrinterStatus getStatus()
{return fStatus;}

public reset() {setStatus("down’ "other"); sendReboot ()}

public Printer()
{ fStatus = new PrinterStatus();
¥

// rot visible at the Mgmt Interface
public Integer getTemerature() {return f Temperature:};

public PrinferStatus getStatus(); (ECIR 0
public void reset(); }
public MonApplication
// The MBean {
public class C orServer htmlAdap

= new
HtmlAdaptorServer();

v {
ObjectInstance htmlAdaptorInstance =
regi daptor, null);

ObjectName mbeanObjectName = new
ObjectName('madynes:id=MyFirstMBean"):

myMBeanServer.createMBean(

“PrinterMBean’,
PrinterMBean);

}
catch(Exception e) { e printStackTrace()}
}

© MADYNES 2003

-22-

X : agent services

* MBeanServer
— MBeans container
— Ensures MBeans naming & registering
» Advanced services
— Monitoring
« Objects attributes
— Numerical values & character chains

— Timer

« Periodical, « one shot »
— MLet

« Dynamic loading of MBeans
— Query

« Selection operation on MBeans
« OSl style Scoping & Filtering
Relationship
« Setup and maintain relationships among managed objects

© MADYNES 2003 _23-

MX:e model

» Events are part of the
JMX model
— Are thus well integrated
in the framework
— Are used in many
fundamental services
of the framework
Java’s Event/Listener
Model
— Emitters
» Broadcaster interface

public class
NotificationListener

public void handleNotification(Nofification notification, Object
handBack)

tem.out )

)

public
[
NotificationFilterSupport nf = new
NotificationFilterSupport();
nf.enableType(new String(« PC.alarm »))
nf,hb;

}

}

— Event consumers

+ Subscription & listeners |,

* Done within one )
MBean Server

public class xtends

e
implements MyPCMBean

© MADYNES 2003
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" JMX : event components

« Notification (CL can be subclassed)

— type: character string which defines the notification type ex.
fr.loria.office.fire

— seq number: in the context of the source
— Time stamp
— message: string describing the cause
— userData: additional data provided by the sender (Java Object)
» NotificationListener (IF)
— handelNoatification(Notification n, Object handback)
« NotificationFilter (IF)
— isNotificationEnabled (invoqué par le broadcaster)
» NotificationBroadcaster (IF)
— getNotificationInfo: lists all notifications that the source can send
— add/RemoveNotificationListener
— sendNotification

© MADYNES 2003 _25.

" JMX & related proposals in the JCP

I
JMX Remoting .. Zl.“ 15
WBEM Services : JMX Discovery (Agent & MBean)
Provider Protocol Adapter | Remote access, proxying, 1IOP Protocol IM.
JMX2CIM, JMX seen asa | Gontext, connectors, alarm | Agapter for JMX.
CIM Provider (Gioriian, .
JSR 146 | RMI; IOP, HTTP JSR 160 JSR 70 1
MBeanServer =
& Agent Services H :
Standard, Dynamic,
JSR 003 Open, Model MBean
JVM Management J2EE Management
& Monitoring
J2SE 1.5 MEJB MBeanServer
JSR 174 | alike JSR77
© MADYNES 2003 - 26-

[ MX : platforms

» Open Source platforms

MX Users (source

+  AdventNet: Agent Toolkit - Java/JMX Edition + .
Manage Engine + Middleware Manager +
Middleware Manager WebLogic Edition +

erience)

Media style GmbH
*  Misys International Banking Systems Ltd:

— MX4J (mx4j.sourceforge.net)
« Full toolkit integration
« Several extensions

— MC4J (mc4j.sourceforge.net)
+ JMX management console
« Compatible with :

— Additional connectors - MX4J
- Met: dell in - JBOSSMX
standard MBeans — JDMK

WebNMS Meridian
BEA: WebLogic +  ObjectWeb: JONAS 2.5, JORAM 3.1
Compiere Open Source ERP & CRM +  Pramati Technologies
Critical Path: Internet File Server, Presentation .
*  Resonate Inc: Resonate Commander

« Apache License
— Open JMX : MX4J predecessor
— JBOSSMX:
« Core of the J2EE JBOSS platform
+ A genious « misuse » of JMX
— XMOJO (xmojo.org, LGPL)
+ Others
- TMX4J
« Tivoli, alphaworks
— JMXRI
+ Reference implementation
— JDMK
* Sun’s offer
— Advent Net JMX Studio
« Development environment & applications

© MADYNES 2003 _27-

Macromedia: FlashMX, JRun 4

Agent B
«  The Jakarta F'rojecl (Apache): Phoenix N
+ JBoss .
+  Log4j .
+  Lutris: EAS

Manage.com: FrontLine Java Management Edition

(JME)

Server, Registered Mail Server, System Console

+  CSC (Scandinavia): LABKA Il Schmid Telecommunication: Pegasus Element

«  Dirig Software: Dirig Agent

+  Hewlett Packard: Core Services Framework + .
HPAS + OpenView

+  IBM/Tivoli

+  IBM: Web Services Toolkit 3.1 , + WebSphere
Business Components + WebSphere Business M
Integrator +WebSphere Voice Server

+ Innovative Systems Design: ITVerify

+  IONA Technologies PLC: iPortal + Orbix + Orbix
E2A XMLBus Edition Technology 2.0

. |Reason|n5i Networks: iReasoning JMX SNMP

Manager

Sonic Software: SonicXQ

SpiritSoft: SpiritWave 5.1 + SpiritWave
Integration Server

Sun Microsystems: Java Dynamic Management
Kit (JOMK) + Netra CT Managed Object
Hierarchy (MOH) + Netra HA Suite + Netra T1
+ DReAM, Distributed Resource Allocation
Manager + SunONE Application Server +
SunONE Portal Server

Sybase: EAServer 4.0

TCC: Rexip AppServer 1.0

Tomcat

Wily Technologies: Introscope

XadrA's VelocityAdaptorServer

Zareus, Inc: Zareus Application Platform

© MADYNES 2003
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[ JMX Deployment Models [KregerHIW/ 03]

* MBean
« JVM Relationship ?
Who owns what ?
* MBeanServer Who initiates what ?
» Application
* Daemon
— Remote Managed Resources

— Agent & MBean can survive
the application & its JVM
— Application must integrate
remote communication
services with the agent
* RMI, SNMP, HTTP, ...

© MADYNES 2003 -29-

| JMX Deployment Models [KregerHIW/ 03]

* Component
— MBS is part of & controlled
by the application
— + access to fine grained
instrumentation
— - needs to be designed in
strong relationship with the
application
* Driver
— Component with inversed
authority role
— MBS bootstraps the
application & its MBeans
— ldeal way of using JMX
— Easy for application lifecycle
management

Application|
JVM

© MADYNES 2003
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] JMX Instrumentation Pattern [KregerHW/ 03]

Application is its own MBean
— MyApplication implements.... MBean
— Usually Standard, Open or Dynamic MBeans

» Managed Object Interface level
— MBean life-cycle usually bound to the application life-cycle & conversely

— Dynamic MBean
Application is separated from its MBean(s)

» Exposed management interface can be built at run
— 1-n MBeans represent the application time !
— Model MBeans are well suited :

+ Especially due to the services they offer « Full control of the interface by the MBean programmer

— Al other (standard, dynamic, open) as well A . |
— MBean Life-cycle can be independent of the application (depends on who « Invocation behavior can Change over time
— If (methodInvocation = “getStatus”) then

instanciates the MBean)

2 additional Instrumentation Patterns defined in [KregerHW 03] R N .
« if (lunchTime == true) return this.busy()
« Else return this.getStatus()

— Publish-only
« MBeans used to offer read-only data information to the management
— Model MBean
* Management interface is build incrementally

console with a well constrained overhead
« Data caching is needed... ModelMBeans can do the work
 Behavior can be tailored (cache management ,
persistence, ...)

[ JMX Dynamics (1)

— Facades
« MBean that aggregates interfaces to other (even remote) MBeans

© MADYNES 2003
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[ JMX Dynamics (2) [ JMX Dynamics (3)

* Remote dynamic loading of MBeans
— Using the MLet service

— Well designed for
« delegation
* Managament interface update

* Notification driven management
orchestration

— Every MO can be a notification emitter
« Just become a notification broadcaster
— Every MO can subscribe to notifications
« Subsription on a per (source, notificationType) basis

— Entire management behavior can be build on
notification exchange
» Even one MO can be a listener of its own

broadcasted notifications and implement its behavior
entirely in the listener

© MADYNES 2003
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[ JMX Dynamics (4) : all together

| JMX Security (1) Access control

» Fancy automated management scenarios
are possible

— Setup a listener on the create/delete &
registration of MBeans

—When a specific MBean appears
« Remote load the corresponding monitoring MBean
— Manage the application

This is Autonomous Management !

* Full part of JIMX 1.2
— Permission-based access control
* MBeanServer permission policies

— What operations of the MBeanServer are allowed to which
application
« create an MBeanServer in/outside a MBeanServer factory
* Release an MBeanServer
+ Find an MBeanServer
* Get/set a builder
— Grant given to applications
— Implemented in the MBeanServerPermissionClass

grant MyApplicationArchive. jar
{
permission javax. MB rPermission “findMB
releaseMBeanServer”;
© MADYNES 2003 _35- © MADYNES 2003 - 36-




[ JMX Security (1) Access control [ JMX Security (3)

* MBean level operations under permission policies
— Instanciation, register/de-register « MBean Trust
— Instance & name search, get, querying . .
— Add/remove NotificationListener — Grant trust to MBeans signed by an authority
- MO Altributes get/set — Only trusted MBeans can register in the server
— MO Metadata access (MBeaninfo) i K i X K
— Operation invocation » Security violation => SecurityException
— Class Loader reference . .
. MBeanPermission Target * Uses the Java security services
— ClassName of the MBean to which the policy applies — Java Authentication & Authorization Service
— ClassMember to which the policy applies (attribute, operation) (JAAS)
— ObjectName to which the policy applies . User authentication AN
rant MyApplicationArchive.jar .
? o el « Access control to methods & objects ﬁ
ermission javax.management.MBeanPermission "StandardPrinter”, “instanciate . . . .
Regsrertbearts — Simple Authentication & Security Layer API
permission javax.management.MBeanPermission "StandardPrinter:reset”, “invoke"); . derucl” Sucurity
permission javax.management.MBeanPermission " StandardPrinter:Status”, “getAttribute”); — Java Secure Socket Extension
permission javax.management.MBeanPermission "StandardPrinter:Status[name="hp1"]", . .
“setAttribute”); * TLS & SSL implementation
3
© MADYNES 2003 _37- © MADYNES 2003 _38-

JSR 160's goals

+ Unclear JSR 03 (JMX) concerning the Client/Agent * From the text:

interactions — "interoperability, transparency, security, and
) - flexibility."
— (RMI) connectors under specified )
— operational model for remote listener . Sz_‘andardlzes at least one protocol between
- client and agent (over RMI)
+ JSR 160 (JMX Remote API) clarifies these points = client independancy from agent implementation
— public draft june 2003 support (§U“v MX4.J, ) _ _
— applies to JMX 1.2 » Remote client side operations mostly like local

Mbean server interface ones

Interface of a

JMX Agent % MBean
Server
JMX Agent o _I.‘.— i' onrectio ‘

Services

Upper Layer =l |l..ii]— I
[E—

© MADYNES 2003 _39- © MADYNES 2003 _40-

" A matter of Connectors Directories of (server) Connectors

* No "JMX directory of services"

* Means to feed existing ones...
— text mode (JMXServiceURL): SLP, JNDI/LDPA
— Stub to JMXServerConnector: JINI, (JNDI/LDPA)
— Basic attributes for (JMX) Services lookup.

aga‘Name:. .

i register
MBeanServerAd 2 register(agentName-=...)
2 newJMXConnector
manager side agent side (on hostl)
© MADYNES 2003 _41- © MADYNES 2003 _42-




Notification handling (1)

» Client/Server context: where are things done ?
— Filtering: on agent (=serialization occurs)
— Listeners on manager
— Handback data on manager (usual case)
— State data linked on Connector connection ("session")
* On client Add/remove Listener: <listener ref, filter ref,
handbackdata ref, ObjectName>
— Filter serialization = dedicated ListenerlD management
» Implemention hints in JSR160: global Notification
buffer linked to a given JMXConnectorServer
— Remote fetch method in a JMXConnect (client) scope

© MADYNES 2003 _43-

"Notification handling (2)

[ TMxComectorserver |

Notif buffer

add(on, |, f, 2 add(on, )

/ \ 4 fetchNotifications \
1d0
session

MBeanServerConnectio

[

Manager side Agent side

© MADYNES 2003 _44-

Implementations

* A mandatory RMI implementation
» A generic Connector: « pluggable transport »
» JMX Message Protocol (JMXMP)

— Optional in conformant implementations

— A « meta » transport protocol
« Handshake phase and profil negociation (l.e: type of
authentification)

— Messages and interactions are clearly described
— Object wrapping (serialization) is hookable
— Not mandatory
— Concrete sample implementation
< Full duplex stream oriented communication interface over TCP
— If you have time during your next vacation :
« Do the SOAP implementation of JMXMP?

© MADYNES 2003 _45-

" JSR 16 : Summary

o +++++
— Very clear and precise specification
— HTTP connectors are no longer part of the standard
— Generic notification subscriber
« Server connector subscribes to all possible MBean broadcasters that
appear in a MBeanServer
* What is not detailled
— Security aspects
« Use of security subject for some interactions
— Classes loading issues
« On manager side (how to ensure which class loader does a
JMXConnector use ?)

« On agent side
— MBean do not need to know all possible Filter class
— How to ensure which class loader does a JMXServerConnector use ?

— All we forgot ;-) ...

© MADYNES 2003 _46-

‘Usefulness for Dynamic Networks

» Connectors are MBeans + Mlet =
Management infrastructure connectivity is easily
configurable
— E.g. dynamic download & setup of connectors
can be context specific !
— Still a bootstrap issue
* RMl is there to solve the problem

* Better security support

© MADYNES 2003 _47-

JMX Remoting : JMXP [draft-harold-jmxp00]
= Application protocol to

access JMX agents
Communication

« BEEP-based
— BEEP profile
« 3 profiles MBEANSERVER,
MBEAN, NOTIFICATION
« 3 allocated channels Charnels
— MBEANServer interactions
: CH1
— NOTIFICATION interaction
CH2
— MBEAN interaction : CH3
— authorization policies
« Java 2 platform security

— provisioning rules

© MADYNES 2003 _48-




A sample exchange scenario

MBeanServer Operations Service
ition on MBeans
Manager JMXP Adapter
Beep Session Establishment - getObjectInstance
« isInstanceOf
Security Setting - isRegistered

+ queryMBeans
s

Open MBeanServer (#1) Channel - unregisterMBeann

- 49-

Chitt QueryMBeans :?faln&rvﬂ' : Eetoetautoonoi
ile anCount
Response codez« 200 » Ch#1 * Notification Subscription Service
- Add Nofification Listener pAceRbreereal erener
Start Nofification Channel (#2) C:MS611.52 120
CComzm Type: application/beep+xml
Chi#: Ready

Response code=« 200 chitt| 5| C <server invocation method=« createMBean »>

C: <arguments>
hit1 CreateMBean ¢ cwaluex<Stringsj Timer</String></values

Response codez« 200, Cch##t C: <valuexObj HE Rt J value>

c: </argumen1s>
Notification h#2) C: </server invocation>
C:END
[s[SrPy 1122187
5 Content Tpe: application/beep+xml
Notification et S i<response code=« 200 »>
S: <valuexObjectInstance classname=« javax.management.Timer,
</value>
time St <value><Obj imers:id=alarmse/Obj alues
S: </arguments>
S: </server invocation>
S:END H
© MADYNES 2003

The MB

an Profile (Channel #3 operatio

CMSG 11.52 120
C:Content Tpe: application/beep+xml

* Get/Set values on MBeans Profile

C:
_ Invoke Parameters : C:<mbean ivocation mbean=« madynes:id=MyFirstMBean »

operation = « setMaxCopies » >

+ Mbean instance name C: <arguments>
+ (attributeName, [AttributeValue] (set | C: <«value><Integer>5¢/Integers></value>
only))* C: </arguments>

C: </mbean invocation>

— OK Response parameters :
C:END

* Mbean instance name
« (attributeName, Attribute Value)*
« MBeanlinfo profile
— Download a MBean metadata (MBean
definition)
« Parameter : target MBean instance
name

* MBean Invocation profile
— Invoke a method (operation) on a
remote MBean
+ Parameters
- MBeaninstance Name
~ Operation name (e.g. reboot) S: </response>
— Operation parameters SEND
— parameterName + Parameter Value

S:RPY 11.22187
SiContent oo application/beep+xml

S :<response code=« 200 »>
St <value>cvoid></void></value>
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[ Notification profile

S:ANS 2 23 . 652 98
5:Content-Type: application/beepsxml
St

+ JMX Notifications T
are issued by a smfpj'”“
server to clients e pa e saege decarmane i reacble text
. . § (/(Is'cear:‘r.:r type>Stringe/scalar-type>
» Clients register first [ onmmesaerconmeers
. . (;is'c:r:‘r.:r-?ype>Long</scnlar-rype>
* Notification
components
— Notification
description
* metadata
— Notification instance LGRS 3000000 g

<item name="timeStamp">
<scalar-typesLonge/scalar-type>
s: <Integer>13</Infeger>
.
values St </menbirs

</item>
<item name="

5 </composite-data>

S: </value>

<scalar-type>Stringe/scalar-type>
item>
s </notification>

SIEND

em name="notificationID">
<scalar-type>Integer</scalar-type>
</item>
3 </s'ruc1ur‘ed— e>
y=valiE
<Strmg)A e related alarme/String>
<Long>42</Long>
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| Encoding & security

+ Scalar types . Secunty Required profiles
— All OpenMBean like standard Types MD5 (authentication)
* Void, Boolean, Byte, Character, String, — TLS (confidentiality)
ong, ...
« Structured b — Combination and other algorithms for
ructured types both authentication & confidentiality
— OpenMBean types
« Tabular
* composite
— Arrays
.« <array>
~ <value>.....</value>
- <value>.... </value>
— Attribute (AVA)
+ <AttributeName, Value>
— Composite
* Simple or structured type (e g a struct),
i.e. the description of the
+ member element (the value of the
type)
— Tabular
+ Simple or structured type
+ +one or more rows
— Dedicated JMX types
+ MBeanlnfo Value
« Ol (class + Obj; )
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" IMX & Legacy

« Example of integration with Iegacy
management
— CMIS/JMX Gateway

JTVN CMIS
Browser

Simple .
Dynamic! i -

Simple
Standard.
Mbeant =

1 [Py

© MADYNES 2003
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| JMXP : pros & cons

* An excellent initiative
— A first proposal of a BEEP-based management protocol
* Notification subscription
— Good to have it available !
— Missing items
« No Filtering, scoping in the JMXP parameters
* « The Blues Brothers » syndrome
— No NotificationType based subscription in the current approach
+ Not even in JMX
— Impossible to subscribe to the following
« lam interested in all Alarms
— Possible
« | am interested in alarms from instance1, instance2, ....
— How to deal with optional data in notifications ?
« Change the metadata in each invocation.
— Not part of the standard protocol so far ©
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TOUMX+ & -

* A marvelous wedding
— Many Javavores, & some OSlrists
* Result:
— OSI management without its limits
— An Agent-toolkit
« Trivial in usage (Ideal learning curve)
« Easy to integrate (Especially if the application is in Java)
— High quality OpenSource implementations
« ...especially MX4J et MC4J, TMX4J, ...
— Outstanding Documentation
« Specs & books & examples
» Real Support of Dynamics
*  Any limits ?
— No neutral information model specification & language
« Well : Java is one and a link to UML is always there
— Agents (or at least the agent part of an application) are necessary in Java ...
I like that ©
— Client (Manager) side or at least remote access (remoting) took time to
appear (JSR 160)
« Now proprietary approaches are deployed (interoperability ?)

* The specification took time but the standard is of great help and very well
described
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" JMX future

Source : “JavaTM Management Extensions (JMXTM): Recent Changes and Ongoing Applications”|
T5 274 presentation at JavaOne 2003 by Eammon Mc. Manus

* Excellent ideas to come

— Metadata support

» @management tag to automate the generation of the
MBean interface

— Hiearchical Management architecture

« Proxy agent (proxy’s remote MBeans in one
JMXServer)

— Reliable Notification Delivery

© MADYNES 2003
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[ Tutorial Outline

« Growing Dynamics and their * SyncML-DM : an Approach for

Impact on Management (20 minutes)  Managing Dynamic Devices (60 min)

— Dynamics — Representation Protocol for Device

— Collapsing time scales Management

— The need for automation and — Device Management Protocol
autonomy — Standardized Objects

— Management solutions for the — Device Management Tree
dynamic world — Security for Device Management

— Standardized approaches «  Case studies (40 min)
— Emerging alternatives — Ad hoc networks management

+ JMX': Dynamic Management . : - ) )
forithrough the Java World (60 miny * COnclusion & discussion (15 min)

— Basic Concepts
— Dynamic components

« Attribute, method & notification
level

* Managed Object level
— Remoting
— Implementations
— Application domains &
instrumentation patterns

© MADYNES 2003
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ronization in

early days (before 2000

Islands of disconnected Information

Device-Vendor-Product-Application specific
synchronization:

Multiple devices
(Phones, PDAs, WebTV)

Major Manufacturers
(Alcatel, Nokia, Ericsson, ..)

Several synchronization products
(TrueSync, FoneSync, Intellisync
Anywhere)

Server Applications
(Lotus Notes, ODBC databases, yahoo..)

The Babel-Synchronization framework

© MADYNES 2003
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[ Towards open data synchronization

2000: creation of the SyncML consortium (www.syncml.org).

Members : More than 600 companies-IBM, Nokia, Motorola,
Ericsson, Matsushita, Symbian, Openwave .....

Objective : Develop an Open Standard for data
Synchronization

Additional Results : Device Management Framework for

managing devices .

Synchronization Markup Language is an Open Specification
for universal synchronization

© MADYNES 2003
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[ Use cases for Device Management

*Troubleshooting

Remote service management
» Personal Management

« Storage Management

¢ Monitoring

+ Software download

*Over the air Mass Configuration
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Challenges in Device Management

Heterogeneous devices @ . =
Many applications 5::_--"_'-; T =

Multiple network
connectivity

Limited resources

© MADYNES 2003
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| Requirements for Device Management

« Operate effectively over wireless and wired networks
« Support a variety of transport protocols

» Support arbitrary networked data

» Enable data access from a variety of applications

« Address the resource limitations of the mobile device

« Build upon existing Internet and Web technologies
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" Wireless/Wired Network Operations

Ubiquitous wireless Redefine Management
1. High network latency 1. Management might be to late
2. Limited bandwidth 2. Manage efficiently (whenever
3. Low reliability of both data it's required without wasting
and connectivity resources)
4.  Dynamic Addresses and 3. Connection Oriented
network connectivity management
5. Firewall, Nats — several 4. Application level naming and
management domains addressing
6.  Out of coverage factors 5. Device initiated management
6 Different Fault behavior
management
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Transport Protocols

Several transport protocols are already used by wireless devices

HTTP (i.e. the Internet)

WSP (the Wireless Session

Protocol, part of the WAP

protocol suite)

* OBEX (i.e. Bluetooth, IrDA, and
other local connectivity)

* Pure TCP/IP networks

* Proprietary wireless

communication protocols

All of them are connection oriented .......
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Multiple Applications

* Allow common data representation

— Common personal data formats,

such as vCard, todo etc.

— Collaborative objects Relational data

— HTML documents
— Binary data

Support extensions towards new data formats

Programming Language Independent

— No API (re) definition

— No Communication Middleware dependency
— XML Message exchanges as a glue

Scope of SyncML

© MADYNES 2003
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XML based framework for
I data synchronization

Message oriented data
exchange protocol

Transport agnostic

Universal deployment

Extension for device
management
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Synchronization Device Information
Protocol
]
‘ R ion Protocol
Device Management P
Protocol S Synct )

Device Management

Framework
H «Command Elements o e I
Transport Technology *Data Description Elements
Bindings *Message Container Elements
© MADYNES 2003 _67- © MADYNES 2003 _68-

[ resentation Protocol - Objective

Container Element

comene fonen,
SynchL Message
1. Specifies the structure of Gontaner Element
SyncML messages et s
2. Defines a vocabulary to
describe management data
and operations =
ontainer Element
3. Core component of the ———

SyncML framework on which Syt Body

all others components are oot descrton sement
based ereten eemens
We will cover them in this order: rmmon Use

o || == | =

«Common Use Elements u
+Protocol Management Elements

Common Use Elements

Sub-elements of Command or SyncHdr used to provide a set of common
functions

<Chal>.

.</Chal> Requesting a specific credentials

..<CmD>
.</CmdID>
..</CmdRef>
</LocURI>

ASCII name of a command

Identifier for a command

ID of a command to which reference is made
Identifies the target/source for an operation

" |dentification Mechanisms

Source : Who is starting the operation or from where data originates
Target : Where operations are performed or where data is copied/replaced/requested

<Target>
<LocURI>http://www.syncml.org/Server</LocURI>
</Target>

URI can represent :

<[Target> Where an operation applies
</Source> Data/Operation Source for an operation 1. aserver
<Final/> End of package flag
1. Chal 1. MsgID ;
<Add> 2. cmd 12, MsgRef 2. device
<CmdID>1</CmdID> i gmﬁb{ f‘ EOEESPH
. e loResults < >] B ings< >
<ltem> 5 Cred 15, Source 3. one data store <LocURI>IMEI:383/Rings</LocURL
<Source> <LocURI>1</LocURI> </Source> 6. Final 16.  SourceRef .
7. Lang 17. Target 4. data item <LocURI>IMEI:383/Rings/ToneA</LocURI>
<Data>...... </Data> 8. LocName 18. TargetRef
</ltem> 9. LocURIL 19. VerDTD <Source>
P 10. MoreData  20. VerProto <LocURI>IMEI:383581748</LocURI>
Complete list of common use elements </Source>
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Protocol Management Element(s

et> <LocURI>./Contacts/John</LocURI Target

Management Operations
(one SyncML Message)

_
_
Agent
Result for each operation
Manager <Status>
<CmdID>4</CmdID>
<MsgRef’ MsgRef>
<Cmd: <Cmd> &—m8 8™
TargetRef><LocURI>./Contacts/John</LocURI> </TargetRef>¢————
[[status Code }———» <Data>401</Data>
</Status>
© MADYNES 2003 _71-

" Sta s Codes (excerp

+ Add
— (200) OK : Command Completed successfully
— (414) URI in command too long
— (500) Command failed —generic code for failures

+ Atomic
— (507) Error occurred when performing an individual command
+ Copy

— (420) Device Full — no space left on device

— (425) Permission Denied — no proper ACL
+ Delete

— (425) Permission Denied — no proper ACL

— (403) Forbidden —node in use

1. Each command is associated to one or several status codes
2. If you know HTTP then you almost know the Status codes
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Command Elements —functional classification

1. Data Command Elements — used to change application data

Add - creates a new interior node

Copy —copies values from a node to another at the client side
Delete — deletes a node (and all its subnodes)

Exec — process execution on the target

Replace — overwites value for an existing node

Get — retrieves data from the target

1. DataStore Command Elements — Actions for an entire datastore

Alert — used for notifications, text displays
Results — contains results from a Get

2. Process Flow Commands — enhanced processing control

Atomic — all subcommands must be executed
Sequence — subcommands must be executed in order

© MADYNES 2003 _73-

The Duo: Get and Results

<MsgID>1</MsgID>

<Get>

<CmdID>2</CmdID>

<Item>

<Target> <LocURI>./Contacts/John</LocURI> </Target>
<ltem>

</Get>

S </MsgRef>
<CmdRef>2</CmdRef>
<CmdID>2</CmdID>

LocURI>./Contacts/John</LocURI> </Source>
<Data>Tel:01564433</Data>

</Ttem>

</Results>

© MADYNES 2003
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Data Description Elements

1. <Data>....</Data> encloses SyncML payload data
<ltem>....</ltem>
« isolates a command from the underlying data
« Contains Data, Identification and Metadata

3. <Meta>.....</Meta> provides meta-information about the
data

* Type of the data
* Size of the data

© MADYNES 2003
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Meta Information

Meta-information related to a SyncML command or data item

<IMeta>
<ltem>

<Size>200</Size>
<Type xmnls='syncml:metinf>text/x-calendar</Type> — MIME calendar format for the entry

<Add>

<CmdID>1</CmdID> Command to add a calendar entry
<Meta> Tag indicating Meta i

<Format xmins=" J t Data encoding is character (non-binary)

_» Size of the entry is 200 bytes

<Data>

</Data>
</ltem>
</Add>

0cURI>./2</LocURI; Location of the entry

© MADYNES 2003
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Container Elements

<SyncML xmnls='SYNCML:SYNCML1.0>
[ <SyncHdr>

<VerDTD>1.0</VerDTD>
*  SyncML is message <SessionID>1</SessionID>

oriented <MsgID>1</MsgID>
<Target>

Message Container

Header Container

<LocURI>http://www.syncml.org/Server</LocURI>

«  Structure of a SyncML
message is similar to
HTTP

<[Target>

<Source>

<LocURI>IMEI:383581748</LocURI>

</Source>

« Three types of containers: </SyncHdr>

— <SyncBody>

1. Message <Get>

Container <CmdiD>1</CmdiD>  Body Container

2. Header Container <:em>t LocURI>./Contacts/John</LocURI> </T: t:
] <Target> <LocURI>./Contacts/John</LocURI> </Target>

3. Body Container o

</Get>

</SyncBody>

</SyncML>

© MADYNES 2003
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Device Management Framework

Describes the management information and how to access it

o

Managed Object

Management Tree | 1. Framework for
describing
management
information

2. Management Tree

O 3. Standardized Objects

© MADYNES 2003
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Purpose of the Device Management Framework:

Generic device description framework SyncML

Describes methodology for describing managed device

Device Model specific to an equipment

ﬂ ﬁ Uses
. Management Protocol

Management Application

models

Managed Device
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Modeling Management Information in SyncML

<!ELEMENT Node (NodeName, Path?, RTProperties?, DFProperties, (Node* | Value?))>
<IELEMENT NodeName (#PCDATA)>

<IELEMENT Path (#PCDATA)>

<IELEMENT Value (#PCDATA)>

<!ELEMENT RTProperties (ACL, Format, Name, Size?, Title?, TStamp?, Type?, VerNo?)>
<!ELEMENT ACL (#PCDATA)>

<IELEMENT Format (b64 | bool | chr | int | node | null | xmi)>

Dynamic self-described management
information @

XML Tree Node captures information
about :

*Name of the managed object

*ACL

*Subtrees

*Value

-Data Type of the Managed Object

® ©

® ® ©

Management Information
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" Framework properties of a Managed Object

DFProperties

\ DFFormat \ \ Description \

\ AccessType \ \ DF Type \

Data Format of the
Which operations are possible ? node
Add, Copy, Delete, Exec, Mime type Eg. bool, chr, int,  Description of the node
Get, Replace of the node value  node, null, xml

Framework properties do not change at run-time.
Analogous to a MIB2 definition
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" Information Modeling with framework properties

DFProperties H Occurence H OneOrN H value=3 ‘

Node

At least one node must occur,
but no more than three times

NodeName

Other possibilities:
*ZeroOrMore : Node can occur unlimited number of times or not at all
*ZeroORN : Node can occur up to N times, or not at all

*OneOrMore : Node can occur unlimited number of times, at least once
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" Runtime Properties of the Managed Object

ACL If used, indicates ACL

RTProperties

NodeName

Name Same as NodeName

Format | Format of the value

Size Size of the node in bytes

Tstamp [Timestamp of last change

Type type of the node
Objective : Describe instantiated Managed Object
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Runtime Properties vs Framework Properties

(Internal Node) Runtime Property Type
Represents the name of a device
description framework document.

T —

Instantiated MO Vendor Document
describing the Managed

Object.

The Framework Property
DFType indicates Mime
type of the node

(Terminal Node) Runtime Property Type
equals DFType from the device
description framework document

Runtime Property Format describes the
data format of the node. Obviously must =———=—
be equal to the DFFFormat property

DFFormat indicates data
format of the node

Do not confuse the two types of properties !
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Access Control Lists (ACL

ACL Property regulate access to a MO
(n)

@ e ACL B

‘ Get=Server A&Replace=Server B ‘ [

ACLC ] [ AcLD ]
ﬁ ACL operation
1. Internal Nodes — access to ACL is
regulated by the ACL itself
i 2. Terminal Nodes — Parent Node ACL
i regulates ACL modifications
3. If ACL empty then closest ancestor
Server A Server B ACL is used
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AccessType

* ACL is Runtime property — AccessType is a device framework
property.

* AccessType specifies what operations are supported — the ACL
specifies who is allowed to perform these operations

* ACL — AccessType interaction in case of dynamic (runtime created)

nodes
Direct Delete Indirect Delete
Command Command
Delete allowed Deleted Deleted
Access Type
Delete not allowed Not deleted Deleted

Indirect delete occurs when an ancestor of the node has to deleted
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[ Addressing Object Values and Properties

Addressing node values : @
Object is identified by complete path to the root of the management tree
Example : <LocURI>NodeA/NodeB</LocURI>

Extended usage of the tags:
Meta, Format, Type Meta to indicate metainformation

Format (string in this example) for the data format via

<Meta> Runtime property Format
<Format>chr</Format> Type =value for the Mime type
<Type>text/plain</Type>

</Meta>

Addressing Property values : node URI+?prop=<property_name>
Example : addressing ACL property of Node B : /SyncML/NodeA/NodeB?prop=ACL
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" Device Management Standardized Objects

Mandatory Device Management Objects for any SyncML device

Management Information Regarding :

—_

Connectivity information (protocol
IPv4/IPV6, addresses, ports)
Accepted authentication methods
Bearer type (eg. Obex, GSM, CDMA)
Management server ID

Manufacturer ID,

Model and Device ID

Software version

S @ W s W

Think MIB 2 for device management.....
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Requirements for the Device Management Protocol

Requirement: Ability to deal with dynamic environments

» Dynamic network connectivity
« Unreliable communication ‘ i

medium !““‘“’ | EM:S;?;?::I
» Not always on-line devices due \
to out of coverage or limited \ ;
mobility management o U ‘
« Limited incoming connections ‘ o &2 Home Network
for devices
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Approach for the Device Management Protocol

Objective: Perform Device Management and allow user interaction in the
management process

Features :
+  Use the Representation Protocol
*  Re-use security framework from the
Synchronization Protocol
+  Un-symmetric since only a server manages

a client
<Replace>
| <CmdID>1</CmdID>
Management Functionality : | <Meta>...</Meta>
| <ltem>

) . | <Target> ‘URI of MO.....</Target>
+ Read/Write/Replace Managed Object | <Data>New value for MO’</Data>

properties | ://léemf N
+  Create Managed Object | </Replace
. Remove Managed Object
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Design choices for the Device Management Protocol

1. Session Oriented
2. Client initiated

3. Out of band notification .
support

XML encoded
5. User interaction enabled

< __Notification

| want to manage you !

Management
Session

Client initiated

Rationale

1. Devices might not be always online

2. Most firewalls will allow only device initiated connections
3. Notification support needed for “server initiated “ sessions
4. User might have other priorities
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[ A Management Session

Package 0
Optional Notifcation

Client Ciont nitates sosson

Package
Server Intiatialsation+mgt

Package 3
Resuls (for mat requests)

Fackage 4
Mg, Requests

Package 3
Rosuls (for mat requests)

PaCKaTE

Package
Results (for mgt requests)

IEELIR

«Five logical packages

*In most cases one package is a
SyncML message

«Oversized packages can be included
in several message

*Protocol state (each site) is
determined by current protocol

© MADYNES 2003
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Wireless

cess Protocol based notificatio

Access network technology
specific

Device is provided information
Push Access
Protocol about :

Push over the air
protocoll

Nareged Darco =1 « Required User interaction
Push Prory Gateway anagerentSenec» Background operation
« Server |dentifier
Package 0 « Session Identifier
Deliver * MD5 authentication
€ y *Vendor specific
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" Client initializati

I
. Package 1 > ‘
I

Managed Device Management

Server
Information about :
« Protocol Version
« Session ID (equal to the
notification)
« Maximum message size accepted
by client
« Client credentials
« Client and Server IDs (URI)
« Initiator - is this a reply to a
notification or a pure client initiated
session ?

<SyncHdr>

<VerDTD>1.1</VerDTD>
<VerProtocol>DM/1.1</VerProtocol>
<SessionID>1</SessionID>
<MsgID>1</MsgID>

<Target>
<LocURI>http://www.server.com</LocURI>
</Target>

<Source>

<LocURI>IMET :03839028</LocURI>
</Source>
<Meta><MaxMsgSize>4000</MaxMsgSize></Meta>

</SyncHdr>
<SyncBody>
<Blert>
<Cmd>1</Cmd>
<Data>200</Data>
</Alert>
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Server initialization

<SyncHdr>

<SessionID>1</SessionID>
<MsgID>2</MsgID>

<Source>
<LocURI>http://www.server.com</LocURI>
</Source>

<Target>
<LocURI>IMEI:03839028</LocURI>
</Target>

<Cred>

| . ) <Meta>

nformation about : <Type>syncml :auth-basic</Type>
« Protocol Version <Format>b64</Format>

« Session ID (equal to the package </Meta>

' < Package 2 @

Management
Server

1 <Data> base64 formated userid:password</Data>
)
: </Cred>
*Server credentials </SyncHdr>
<SyncBody>

Additional status information abou <Status>

Kage 1 ds and header, <ISIReE>1</MsgReE><CnARe £>0</CndRe £>
package 1 commands and header. cnq-synchdr</cnd>

<TargetRef>http://www.server.com</TargetRef>
<SourceRef>IMEI:03839028</SourceRef>
<Data>212</Data> (Remember error codes)

Additional commands
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=
. Package3 >
Managed Device Mem ont
Server

Information about :
« Session ID

Request

of the package

« Server Authentication (package 2)
« Session ID (equal to the package 1,2)
« Status of management operations
«+ Results if package 2 contained a Get

« Last message in this package must
contain the <Final> tag to mark the end <Item>

| Client Response

<SyncHdr>
</SyncHdr>
<SyncBody>
<Status>
<CmdID>5</CmdID>
<MsgRef>2</MsgRef>
<CmdRef>0</CmdRef>
<Cmd>SyncHdr</Cmd>
<Data>212</Data>
</Status>

<Results>

<CmdID>6</CmdID>
<CmdRef>1</CmdRef>
<MsgRef>2<MsgRef>
<Cmd>Get</Cmd>

<item>

<Source>..</Source>
<Data>Returned value</Data>

</Results>
<Final/>
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Management goes on

<SyncHdr>
. Package 4 </SyncHdr>
<SyncBody>
Managed Device Management 7,
Server <CmdID>8</CmdID>
<Meta>
<Format>b64</Format>
<Type>Mime type of MO</Type>
</Meta>
X . <Item>
1. Status information about message <Target>
header in package 3 <LocURI>URI of MO</LocURI>
. </Target>
2. Additional Commands <Data>B64 encoded value for
3. Format and Type of the managed the MO
object (MO) </Data>
4. Last message contains the <Final> </
<Final/>
tag
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Basic initial configuration of the “Management” agent and transport connection

Existing Approaches :

. Out of band signaling (WAP Push)
. SIM card
. Pre-programmed
SyncML Bootstrap Protocol :

Provides Management Server address to Client
Authentication settings (Proof of Server ID)

Network level configuration setting for the communication
(TCP/HTTP)

© MADYNES 2003
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[ Security in SyncML Management

Device Server
OJ 1. Authentication of Server
. 2. Integrity check of the message
(MD5/basic authentication)
1. Two way authentication
2. Integrity check of the
message

3. Access Control List
mechanism

{ 4. Confidentiality provided by
transport level

(HTTPS, SSL, OBEX)
© MADYNES 2003
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Manage you wherever you are

« Ubiquitous management protocol

« Transport independent

« Bindings defined for short-range communication technologies as
well as over IP/HTTP connections

POST ./servlet/syncit HITP/1/.1
Host: www.mydevice.com
Content-Type :
application/vnd.syncml+xm;
Charset="utf-8”

SyneML SyncML

o omex N

—T Content-Length: 1023
DA == Accept: application/vnd.syncml+xml
e <SyncML>
S <SyncHde>
wrTe | SyncML e
i </SyncML>
SyncML /HTTP example
Simple Idea : Embed any SyncML message in a POST request
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Existing Implementations

Proprietary implementations :
Major actors and contributors to the standard.
Open Source :
Sync4J (http://syncdj.sourceforge.net) for the data
synchronization.
No device management functionality.

LORIA/MADYNES :

SyncML toolkit available :
http://www.madynes.org/software.html
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[ SyncML DM summary

. SyncML DM is more than just XML based configuration
. Framework for describing management information
. A set of standard Managed Objects
. Transaction oriented Management Protocol
. Network level transport agnostic
. Flexible Access Control
. Adaptation of conceptual design approaches from the SNMP
framework towards device mobility
- Similar building blocks to the SMI, MIB2 and SNMP and Get/Set semantics
- Reversed roles : a managed Device initiates a management session
- Power for the users : allow/deny management actions
. What to expect
- More OpenSource implementations
- Interoperability studies
- Performance analysis and large scale deployment tests
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*  Case studies (40 min)
— Ad hoc networks management
« Conclusion & discussion (15 min)
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Case Study of Dynamic Networks
Ad Hoc Networks

1. ANMP
1. SNMP clustering
2. GMA

1. Clustering & active code

3.  Policy-based approaches
1. COPS-PR Clustering for QoS provisionning
2. Anode-to-node policy exchange model
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[ Ad hoc network

» Autonomous wireless
networks
— No infrastructure (predefined)
— No pre-configuration
— With OR without connectivity
to a fixed network
* Dual role entities
— Any entity is both a terminal
and a router
* Dynamic features
— Limited & variable bandwidth
— Power availability
* Why accept management ?

— Entities in the network are
volunteers to interact and
provide the best possible
service
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Ad hoc networks dynamics & Management Requirements

+ Topology & connectivity
— Connectivity among elements
— Connectivity with an Internet Gateway
+ Element capacity & constraints
— Power variation & constaints over time
— Limited CPU & storage capacity
Management Requirements
— Automation
— Dynamic Configuration/Reconfiguration
— Varying management roles & capacity in participating entities
+ From minimal participants (e.g. sensors, PDAs)
+ To full fledged management entities (e.g. gateway, PC-based terminal, ...)
— Management needs to be lightweight
* Management overhead needs to be balanced against its cost
« Limit the management trafic & processing
« Efficient management
— Security (including a secure management plane)
Management of a timely limited (temporary) world
— Poor connectivity & high packet loss
» Management plane must be robust
— Some traditional faults are NOT necessarilly faults anymore
« E.g. disappearing node
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ANMP : Ad hoc Network Management Protocol chenJs ooj

* Focused functions

— Configuration management
» Network partitions, merge
« Node connect, disconnect, Join, leave, death, birth,

power on/off,

— Fault Management

— Monitoring (Data collection)
« Manager rooted Spanning tree for polling

« Trap-based update (on change data propagation)
— Limit the communication on data change
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| ANMP architecture & solution

» 3 level management hierarchy

— Top-level Manager
« Can be an agent towards a wired
manager
— Cluster heads (1st level agents &
Managers)
* SNMP compatibility
— Data is exchanged via SNMP
compatible PDUs
— Managament information is located in
SNMP MIBs
» Clusters of neighbors
— 2 clustering algorithms
« Graph-based clustering algorithm
— One hop neighbors (direct)
« Geographical clustering algorithm
— Up to 3 hop neighbors in a cluster
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[ ANMP : Graph-based clustering

« Distributed clustering algorithm & protocol
— Link between 2 nodes = in transmission range
— Clusterhead = node with the smallest ID
< ID is a unique identifier
— Static :
« MAC @,
« Serial Number

— Dynamic :
« EnergyLevel + MAC@ AN
- IP@

* Node internal data structures

« Distributed mobility processing algorithm 2|0 o 0@ Q )
— List of neighbors Cluster head guest — Done at the cluster level ° o 0
. . ! + Leaving node send disjoin when leaving a cluster 4 .% =
— list of nodes in the C|uster’ « Joining node sends Join message to cluster head o) @ o
) h . . when joining a cluster 9|°@® g0 @ )
— Ping counter (last time, logical, a ping was - Guest facility in each box for nearby unmanaged o [¢)
reCeWed fI'Om the C|USter head) + If node density changes (over nax, under min) 4 9] .
recompute clustering 5 3 6 4 5 3
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| Geographical clustering algorithm

2 level clustering algorithm Cluster computation

— Node positions are known through GPS ;
- S\L;,entrallzed / Periodical processing for cluster

efinition o I o

9 o
— Adistributed processing algorithm to manage node o S eole P O
mobility 4 @ ..| Q
Central periodic clustering algorithm oy oo

— Periodically initiated by the Manager 9 09 © o) Q)

+ Calculation of stripes (0]

« Valley selection & division 6 o o

+ Max distance for a box = 3x transmission range
+ Density adjustment facilities

— Node density sensitive
 min, max # of nodes / cluster

ANMP Management Information Base

Power Usage MIB Group

« External Power : Y/N
« Remaining Power (watts-hour)
« Current Power mode
+ Power mode costs
— Power mode table (sleep, idle, active, ...)
— Consumption in each mode
- Battery —
— Age, type, serial#, last recharge time
— Drain model (description, function)

» Radio Interface Power table
— 1 Entry / interface % k\‘/ k
— 32 bytes transmit/receive power

— Power consumed in idle mode
— Power consumption in sleep mode

802.11a/6lg &PRS Bluetooth
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ANMP Management Information Base & applications

« Topology group
— Neighbor table
« List of IP@ of all direct neighbors

— List of supported topology
protocols

« Clustering protocols : graphical,
geographical

— # of current used topology
maintenance protocol
— Cluster protocols specific data
« clusterlD, #nodes in the cluster, ...
» Applications
— MIB 2 monitoring
— Topology discovery
— Power monitoring & management

« E.g.Kforcing a device to stay in
alive mode
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[ ANMP Agent Information

» Maintained by the Manager & each cluster head
— Information Update Interval (ms)

- %managed agents, %managed agents updated info
available
— Data collection tables (control + data tables)
* Managed nodes power information
— Control : number of samples stored, to be measured, sampling
interval,
* M2M notification communication facility

— Manager configures events to be sent by the cluster
heads

— Manager delegates monitoring (e.g. threshold
monitoring) to clusterheads, through setting the control
tables

— Clusterhead selected alarm can lead to event issuance
to the manager
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" ANMP Security

» Level Based Access Control Model (LACM)
» Each node has a Clearance Level
— The Higher the level the lower the security access
« 1:access granted to manager with level O clearance certificates
« 4 :access granted to manager with level 0,1,2,3
— Clearance Ids are certificates
— Clearance Ids are distributed by the manager to the nodes
» Data (mib objects) is grouped into projects

— Each project (set of managed objects) has a clearance level which
defines who can access it

* LACM effect on clustering

— Cluster heads should have clearance to access managed nodes
data

— If Not, they are always bypassed by the node
« Node encrypt data so it can only be decrypted by the manager
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[ ANMP : Summary

* A very complete SNMP compatible management architecture proposal
— Good information models
« Afirst identification of a need for some active code facility
— ftp download of code,
- Astspciation of the entry point of the code (function name) to alarms or event
entries
» An outstanding contribution to the field
— Interesting Clearance level based security model
* Very good coverage of mobile ad hoc nodes
— >90% cluster-level managed nodes
— No configuration transfert among clusterheads in cluster formation
« Everything is conditioned to manager operations
— Multicasting service usage not clear in the context of management
— No clear definition of the right cluster size and its relationship to the
management operations
« E.g. monitoring frequency
— Limited management functions
« Topology discovery, + power status & management
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Guerilla Management Architecture fshenss02]

* Management Architecture for ad hoc networks
* Goals : make management operational in highly dynamic
networks
— Maintain connectivity in the management plane within a managed ad
hoc network
— Minimize Management costs on :
- CPU
* Memory
« Power consumption
— Enable Disconnected Management !
* Approach
— « Context-Aware » Self-configuration of the management plane
— Hierarchical Management Framework

— Management agency : a set of agents can speak as an agent for any
other

— Dynamic code deployment on active probes
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" GMA : Architecture

» SNMP Device (present in all devices)
» Active probe

* Nomadic Manager

» Management federation (agency)

» Supervisor
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| GMA : Component details

» Active Probe
— Extension to the SNMP Agent
— EE for hosting monitoring scripts
« Both local monitoring and surrounding simple

SNMP devices . Nomadic Manager Modlule
— Deployed by Nomadic Managers & Guerilla MIB
» Nomadic Manager T 7
— Maintains connectivity in the Management Probe
Plane with other Managers Agent || i
— Decides to update the management plane & MIB Engine
configuration
« E.g. can spawn new managers in other nodes Network Layer I
— Holds management policies (rules) from the Active network layer
Supenvisor
— Maintains a Guerilla MIB
« Aggregation of data collected from the active
probes
« Supervisor
— The manager
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[ GMA : Protocol components

» Connectivity & management plane topology
— Nodes send beacons (hello’s)
— Nomadic Manager decides of its coverage domain
« Can spawn a new nomadic manager to split a domain
« Can rely on the Adaptive Dynamic Backbone clustering protocol for self-
configuration of domains
— Builds trees of nodes rooted in an Nomadic Manager
— Maximize a utility function to select the management function to
perform
« U = f(powerUsage,CPU Load, ManagementGain, ...)

»»
e (o (B> (=
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| GMA : Management plane clustering algorithm

* Relies on the CLTC algorithm

— Initially a power management protocol

« k connectivity with minimized power consumption
power assignment
— Cluster-based Topology Control
« 2 level topology control
— Intra-cluster
— Inter-cluster heads
« 3 phase power level calculation
— 1 : clusters establishment
— 2: intra-cluster power assignment
— 3 : inter cluster power assignment
« K connectivity enforcement among clusters
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[ GMA : Summary

* A MbD approach
— Topology & power dynamics
— Code mobility
» Heterogeneous Devices considered
— ManagementRole = f(Device capacity)
» Fundamental Good Assumptions
— Self-organization of the management plane is necessary
— Disconnected management can be done

« Limits - Dec:ngrzliéed ,C.OP.S_PRd out , pin
. . Tl rovisionning an utsourcin
— So far no value-added management service deployed on the m{,dﬂ 9 9
fEramevtv;:k t of th ‘ol topol itself — Clustering & Cluster Management
- ch:epb.rte.managemen to e mgnagetmen plane topology itse — Dynamic Service Redundancy
— Scaablliy '.Ssues are not convincing ye — Service Location Discovery (find the
» Open Questions PDP)
— Why do we still need a manager ?
© MADYNES 2003 _121- © MADYNES 2003 _122-

| Policy-based Approaches phanse 02

» Context : QoS management in the
ad hoc plane :
— Resource usage authorization rop
— Policy-based admission control
— Dynamic bandwidth allocation
— Differentiation provisioning
— Monitoring
* Approach

Super PDP

Ccb il

[ Clustering

» K-Clustering

— Maximum K hops away from a
policy server

— Aclient can be served by a server
that is less than k-hops away
« Initial Deployment

— Super PDPs are present in the
network

» Redirection service

— A server (PDP) can dynamically
redirect a client to a less distant
PDP

— Redirection is Server initiated
» Delegation Service

— A PDP can delegate part of its
decisions to another PDP
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Extensions

* Multi-domain policy negociation
— Inter-PDP signaling

— Home PDP + Last PDP fields in
COPS messages

— If no policies found by the visited
PDP => negociation with the
HomePDP

— Negociation = Policy download
* Possible improvements (OF)
— Policy transfert during redirection

— PEPs could « come with » their
own policies
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Node-to-node policy exchange approach [MunarettoAF 02]

Device 8
[
[er]

+ Context : Corporate ad hoc networks
— Uniform management & company wide
policies
* Management function
— Diffserv-like QoS management in the ad-
hoc network
* Approach
— Every ad-hoc device exports both
functions
« Edge router (marking, metering, policing,
shaping)
— Acts on local applications
« Core router (classifying, schedulling,...)
— Acts on routed packets
* Management Plane
— Each ad-hoc device embeds both ‘
« PDP + Policy Repository
+ PEP

MAC QoS Elements ‘
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N2N addressed problems jmunarettoAF 02

» 2 phases policy distribution &
synchronization
— 1: feed the PIBs of connected devices
« Manager is a PDP
+ Ad-hoc nodes are in a PEP role
— 2: permament synchronization among
2 meeting devices
« Applied to new entrants
» Policy authority
— Management Hierarchy with delegation
— Policies are tagged by managerID
— Each managerlD has an authority level
known by all

— The more authoritative policy always
replaces less ones

Phase 1: Policy distribution by
Prime network management

«po s

» K )
policy Synchronization gy
& N

Phase 2: Policy snchronization
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[ N2N Policy exchange approach

* Summary
— A focused approach
« Corporate
— An interesting approach
« Device level Policy Management Framework
» Current limits
— Synchronization protocol not described
— Some open problems on policies consistency
— No description of addressed policies & policy levels
— Hierarchical authority model is not sufficient to cover
security issues at all !
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[ Ad hoc management summary

» Other approaches
- MARE
« Used mainly for service location
» Mobile agents + distributed tuple-space

» Common vision of the problems
— Management overhead must be minimized

 Similar approaches
— Clustering (various algorithms)

— Delegation (agents, active code, extensible
SNMP agent, ...)
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« Conclusion & discussion (75 min)
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[ Conclusion (1)

» Dynamics is a growing parameter in the management
plane
— Dynamics is everywhere
— The research community is starting to address the problem
* Ad-hoc management is one example
— Few initiatives so far
— Similar approaches
« Clustering
 Delegation
» Some approaches enable dynamic management
— Or at least some parts of it
» Other initiatives contribute as well to the field
— E.g. Debussmann’s auto-instrumentation proposals
— Jini-based federations of autonomous management architectures
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Conclusion (2): Is the answer in standards ?

IBM

JCP DMTF
TeleManagement Forum

CISco
NORTEL ALCATEL

ATET ITU-T MMA?

SIEMENS oME
SN o LUCENT ETSI ITL IEEE  gyx
= NEC IETF  Open Group

NTT DEC-COMPAQ-HP

OASIS

TOSHIBA

How many standardization Consortia can be built from n proprietary
solutions, given that a standard requires at least 2 companies to be
established.

Be careful, everything you standardize today becomes the legacy of
tomorrow !
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Conclusion (3) : The management future according to MADYNES

* Management will not disappear !
— At least we hope it will not.
» The management future will be a mixture of :
— (option 1) management of static only parts
— (option 3) smart & automated management techniques
» Efforts must be maintained in both directions
— Standards can play a role in both options as well
— But are not the overall success condition
» Research may be more “sexy” in option 3
— Covers & integrates potentially many fields & techniques
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Conclusion (4) : advice

To young researchers & Ph.D. students in the discipline
* Management needs NEW models and techniques
+ Be creative
— Do not stick to standards and implementation details
— Free your mind !
— Incremental research as a backup
« Validate your ideas
— Models exist, environments too Mordillo drawings
— Formalize your protocols
— Simulate their behavior
— Evaluate the performance
— Implement when sounded
+ Cooperate
— There is a management discipline with an associated
community of some very pleasant, motivated and competent
people
+ Be hungry of history
— IM, LISA, DSOM, NOMS, MMNS,
— « The one that does not know where he comes from , does not

know where he is heading to because he does not know where
he is ! » from ??22?
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